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Important Information
Warranty
The SCXI-1521 and SCXI-1521B are warranted against defects in materials and workmanship for a period of one year from the date of
shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to
be defective during the warranty period. This warranty includes parts and labor.
The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in
materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National Instruments
will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects
during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.
A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any
equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by
warranty.
National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In
the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document
without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. In no event shall National
Instruments be liable for any damages arising out of or related to this document or the information contained in it.
EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL
INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING
FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of
the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against
National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service
failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the
product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside
reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying,
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National
Instruments Corporation.
National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other
intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only
to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section
on ni.com/legal for more information about National Instruments trademarks.
Product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT
INJURY TO A HUMAN.
(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY,
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE
COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES,
TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR
ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER
COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF
HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY
UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH,
THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES,
INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS
CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION
DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT
EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY
RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER
NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT
LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.

Conventions
The following conventions are used in this manual:
<>

Angle brackets that contain numbers separated by an ellipsis represent a
range of values associated with a bit or signal name—for example,
P0.<3..0>.

»

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.
This icon denotes a note, which alerts you to important information.
This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this icon is marked on the
product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.
When symbol is marked on a product it denotes a warning advising you to
take precautions to avoid electrical shock.
When symbol is marked on a product it denotes a component that may be
hot. Touching this component may result in bodily injury.

bold

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

italic

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

monospace

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

monospace bold

Bold text in this font denotes the messages and responses that the computer
automatically prints to the screen. This font also emphasizes lines of code
that are different from the other examples.

SCXI-1521/B

SCXI-1521/B refers to both the SCXI-1521 and the SCXI-1521B module,
unless otherwise noted.
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About the SCXI-1521/B

This chapter introduces the SCXI-1521/B module, and explains how to
install the software and hardware.
Descriptions in this chapter explicitly refer to the first channel (channel 0), but these
descriptions also are applicable to the remaining 23 channels.

Note

The SCXI-1521 and SCXI-1521B modules are 24-channel modules for
interfacing to quarter-bridge strain gauges and are configured using
Measurement & Automation Explorer (MAX) or through NI-DAQmx
property nodes. The SCXI-1521 has 350 Ω completion resistors while the
SCXI-1521B has 120 Ω completion resistors.
The SCXI-1521/B includes the following functionality:
•

DC voltage excitation between 0 and 5 V in 1023 steps

•

Programmable offset nulling circuitry

•

10 Hz lowpass filter

•

Analog input gain of 42 V/V

•

Software controllable shunt calibration

What You Need to Get Started
To set up and use the SCXI-1521/B, you need the following:

❑ Hardware

© National Instruments Corporation

–

SCXI-1521/B module

–

SCXI-1317 terminal block

–

SCXI or PXI/SCXI combo chassis

–

Computer if using an SCXI chassis

–

Cabling, cable adapter, and sensors as required for your
application

1-1

SCXI-1521/B User Manual

Chapter 1

About the SCXI-1521/B

❑ Software
–

NI-DAQmx 7.3 or later

–

One of the following software packages:
•

LabVIEW

•

LabWindows™/CVI™

❑ Documentation
–

Read Me First: Safety and Radio-Frequency Interference

–

DAQ Getting Started Guide

–

SCXI Quick Start Guide

–

SCXI-1521/B User Manual

–

SCXI-1317 Terminal Block Installation Guide

–

Documentation for your software

The optional accessories listed in Table 1-1 are available for the
SCXI-1521/B.
Table 1-1. Accessories Available for the SCXI-1521/B

Accessory

Description

SCXI-1317

Screw terminal block—Mounts on the front of the SCXI-1521/B module and
provides easy access to the terminal for field wiring connections.

SCXI-1310

Connector and shell assembly—Provides 96 eyelet-type terminals for easy
hook-and-solder signal connection and custom mass termination connectivity.

TBX-96

DIN-rail mounted terminal block with 96 generic screw terminals.
One of the following cables is required to connect the TBX-96 to an SCXI
module:

SCXI-1521/B User Manual

•

SH96-96 shielded cable, 1 m

•

R96-96 unshielded ribbon cable, 1 m
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National Instruments Documentation
The SCXI-1521/B User Manual is one piece of the documentation set for
data acquisition (DAQ) systems. You could have any of several types of
manuals depending on the hardware and software in the system. Use the
manuals you have as follows:
•

SCXI or PXI/SCXI chassis manual—Read this manual for
maintenance information about the chassis and for installation
instructions.

•

The DAQ Getting Started Guide—This document has information
about installing NI-DAQ and the E/M Series DAQ device. Install these
before you install the SCXI module.

•

The SCXI Quick Start Guide—This document contains a quick
overview for setting up an SCXI chassis, installing SCXI modules and
terminal blocks, and attaching sensors. It also describes setting up the
SCXI system in MAX.

•

The SCXI hardware user manuals—Read these manuals next for
detailed information about signal connections and module
configuration. They also explain, in greater detail, how the module
works and contain application hints.

•

Accessory installation guides or manuals—If you are using accessory
products, read the terminal block and cable assembly installation
guides. They explain how to physically connect the relevant pieces of
the system. Consult these guides when you are making the
connections.

•

The E/M Series DAQ device documentation—This documentation has
detailed information about the E/M Series DAQ device that plugs into
or is connected to the computer. Use this documentation for hardware
installation and configuration instructions, specification information
about the E/M Series DAQ device, and application hints.

•

Software documentation—You may have both application software
and NI-DAQ software documentation. National Instruments (NI)
application software includes LabVIEW, LabWindows/CVI, and
Measurement Studio. After you set up the hardware system, use
either your application software documentation or the NI-DAQ
documentation to help you write your application. If you have a large,
complex system, it is worthwhile to look through the software
documentation before you configure the hardware.

© National Instruments Corporation
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•

The Start»Programs»National Instruments»NI-DAQ»
NI-DAQmx Help files for software information.

•

NI strain-gauge application notes or tutorials—NI has additional
material about strain gauges and strain measurements available at
ni.com/support.

You can download NI documents from ni.com/manuals.

Installing the Application Software, NI-DAQ, and the
DAQ Device
Refer to the DAQ Getting Started Guide, packaged with the NI-DAQ
software, to install your application software, NI-DAQ driver software, and
the DAQ device to which you will connect the SCXI-1521/B.
NI-DAQmx 7.3 or later is required to configure and program the
SCXI-1521/B module. If you do not have NI-DAQmx 7.3 or later, you can
either contact an NI sales representative to request it on a CD or download
the latest NI-DAQ version from ni.com.

Installing the SCXI-1521/B
Refer to the Read Me First: Radio-Frequency Interference document before
removing equipment covers or connecting or disconnecting any signal wires.

Note

Refer to the SCXI Quick Start Guide to unpack and install the SCXI-1521/B
in an SCXI chassis. After installing the SCXI-1521/B, power on the SCXI
chassis.

Connecting the SCXI-1521/B to an E/M Series DAQ Device for
Multiplexed Scanning in a PXI/SCXI Combination Chassis
In this configuration, you can multiplex all 24 channels of the
SCXI-1521/B into a single channel of the E/M Series DAQ device, in
the right-most slot, using the PXI backplane in a PXI/SCXI combination
chassis.
Consult the PXI/SCXI chassis documentation, the documentation of other
SCXI modules, and E/M Series DAQ device documentation for additional
instructions and cautions. You should have already installed your software,

SCXI-1521/B User Manual
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and inserted the SCXI-1521/B module and any other SCXI modules in the
chassis according to the instructions in the SCXI Quick Start Guide.
To use the SCXI-1521/B module in multiplexed mode with an E/M Series
DAQ device in a PXI/SCXI combination chassis, complete the following
steps:
Notes No cables are required between the SCXI-1521/B and the E/M Series DAQ device

if the E/M Series DAQ device is installed in the right-most PXI slot. You can configure this
device to control the SCXI system using an internal bus that connects the PXI chassis to
the SCXI chassis.
When using the PXI-1011 combination chassis, you can only control the SCXI modules
through the backplane. Parallel mode operation is not available with the PXI-1011 chassis
and is not supported by the SCXI-1521/B.
1.

Make sure the appropriate software is already installed or install it.

2.

If the E/M Series DAQ device for controlling the SCXI system is not
installed in the right-most slot of the PXI-1010 combination chassis,
install it.

3.

Power on the SCXI portion of the PXI combination chassis.

Refer to Chapter 3, Configuring and Testing, to configure the
SCXI-1521/B.

Verifying and Self-Testing the Installation
To test the installation of the SCXI chassis, complete the following steps:
1.

Verify that the chassis is powered on and correctly connected to an
E/M Series DAQ device.

2.

Launch MAX.

3.

Display the list of devices and interfaces by clicking the + next to the
Devices and Interfaces icon.

4.

From the list that appears, locate the chassis you want to test.
Right-click the chassis and select Test.

5.

If the SCXI chassis is installed properly, a message indicating
successful verification appears. Click OK.

The SCXI system should now operate properly with your ADE software. If
the test did not complete successfully, refer to Chapter 3, Configuring and
Testing, for troubleshooting steps.

© National Instruments Corporation
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If you are using NI-DAQmx, you can verify each module in the SCXI
chassis. To test the successful installation of each module, complete the
following steps:
1.

Verify that the chassis is powered on and correctly connected to an
E/M Series DAQ device.

2.

Launch MAX.

3.

Display the list of devices and interfaces by clicking the + next to the
Devices and Interfaces icon.

4.

From the list that appears, locate the chassis with the module you want
to test.

5.

Display the list of modules in the chassis by clicking the + next to the
chassis with the module you want to test.

6.

Right-click the module you want to test and select Test Panels.

7.

If the Error Details box reads No Errors, you have successfully
installed the module.

The SCXI system should now operate properly with your ADE software. If
the test did not complete successfully, refer to Chapter 3, Configuring and
Testing, for troubleshooting steps.

Troubleshooting the Self-Test Verification
If the Self-Test Verification did not verify the chassis configuration,
complete the steps in this section to troubleshoot the SCXI configuration
of NI-DAQmx.
•

SCXI-1521/B User Manual

If you get a Verify SCXI Chassis message box showing the SCXI
chassis model number, Chassis ID: x, and one or more messages
stating Slot Number: x Configuration has module: SCXI-XXXX or
1521/B, hardware in chassis is: Empty, take the following
troubleshooting actions:
–

Make sure the SCXI chassis is powered on.

–

Make sure all SCXI modules are properly installed in the chassis.

–

Make sure the cable between the SCXI chassis and E/M Series
DAQ device is properly connected.

–

Inspect the cable connectors for bent pins.
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–

Make sure you are using the correct NI cable assembly for your
application.

–

Test the E/M Series DAQ device to verify it is working properly.
Refer to the E/M Series DAQ device help file for more
information.

If you get a Verify SCXI Chassis message box showing the SCXI
chassis model number, Chassis ID: x, and the message Slot
Number: x Configuration has module: SCXI-XXXX or 1521/B,
hardware in chassis is: SCXI-YYYY, 1521/B, or Empty, complete the
following troubleshooting steps to correct the error.
1.

Expand the list of NI-DAQmx devices by clicking the + next to
NI-DAQmx Devices.

2.

Right-click the SCXI chassis and click Properties to load the
chassis configurator.

3.

Under the Modules tab, ensure that the cabled module is listed in
the correct slot.

4.

If the cabled module is not listed in the correct slot, complete the
following troubleshooting steps:
a.

If the cabled module is not listed in the correct slot and the
slot is empty, click the drop-down listbox next to the correct
slot and select the cabled module. Click OK.

b.

If another module appears where the cabled module should
be, click the drop-down listbox next to the correct slot and
select the cabled module. A message box appears asking you
to confirm the module replacement. Click OK. Configure the
cabled module. Click OK.

•

Ensure that you have the highest priority SCXI module cabled to the
E/M Series DAQ device. Refer to the SCXI Quick Start Guide to find
out which SCXI module in the chassis should be cabled to the
E/M Series DAQ device.

•

After checking the preceding items, retest the SCXI chassis.

If these measures do not successfully configure the SCXI system, contact
NI. Refer to the Signal Conditioning Technical Support Information
document for contact information.

© National Instruments Corporation
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Connecting Signals

This chapter describes how to connect quarter-bridge strain gauges to the
SCXI-1521/B through the SCXI-1317. It also provides the front and rear
signal pin assignments of the module.
To connect a quarter-bridge strain gauge in configuration type I with either
a 2- or 3-wire strain gauge, refer to the SCXI-1317 Terminal Block
Installation Guide. Refer to Chapter 4, Theory of Operation, for a
discussion of strain-gauge concepts.

Pin Assignments
The pin assignments for the SCXI-1521/B front signal connector are shown
in Table 2-1. The front signal connector is a special 96-pin DIN C male
connector through which you make all signal connections. In the following
list of terminal assignments X is the channel number:
•

EX + X connects to the sensor excitation

•

QTR X connects to the quarter-bridge completion resistor

•

AI X connects to the amplifier terminal

The pins labeled RSVD are reserved. Do not make any connections to
these pins.

© National Instruments Corporation
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Table 2-1. Front Signal Pin Assignments
Front Connector Diagram

Pin Number

Column A

Column B

Column C

32

EX + 0

QTR 0

AI 0

31

EX + 1

QTR 1

AI 1

30

EX + 2

QTR 2

AI 2

29

EX + 3

QTR 3

AI 3

28

RSVD

QTR 4

AI 4

27

RSVD

QTR 5

AI 5

29

26

RSVD

EX + 4

RSVD

28

25

RSVD

EX + 5

RSVD

24

EX + 6

QTR 6

AI 6

23

EX + 7

QTR 7

AI 7

24

22

EX + 8

QTR 8

AI 8

23

21

EX + 9

QTR 9

AI 9

22

20

RSVD

QTR 10

AI 10

19

RSVD

QTR 11

AI 11

19

18

RSVD

EX + 10

RSVD

18

17

RSVD

EX + 11

RSVD

17

16

EX + 12

QTR 12

AI 12

15

EX + 13

QTR 13

AI 13

14

14

EX + 14

QTR 14

AI 14

13

13

EX + 15

QTR 15

AI 15

12

12

RSVD

QTR 16

AI 16

11

RSVD

QTR 17

AI 17

10

RSVD

EX + 16

RSVD

8

9

RSVD

EX + 17

RSVD

7

8

EX + 18

QTR 18

AI 18

7

EX + 19

QTR 19

AI 19

6

EX + 20

QTR 20

AI 20

3

5

EX + 21

QTR 21

AI 21

2

4

RSVD

QTR 22

AI 22

1

3

RSVD

QTR 23

AI 23

2

RSVD

EX + 22

RSVD

1

RSVD

EX + 23

RSVD

Column
A
B
C
32
31
30

27
26
25

21
20

16
15

11
10
9

6
5
4

SCXI-1521/B User Manual

2-2

ni.com

Chapter 2

Connecting Signals

The rear signal connector is a 50-pin male cable connector used for analog
signal connectivity and communication between the SCXI-1521/B and the
connected E/M Series DAQ device. Table 2-2 shows the rear signal
connector and lists the pin assignments for the SCXI-1521/B. Grounding
signals AI GND and OUT REF provide reference signals needed in the
various analog input referencing modes on the E/M Series DAQ device.
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Table 2-2. Rear Signal Pin Assignments
Rear Connector
Diagram

1
3
5
7
9
11
13
15
17
19
21
23
25
27
29
31
33
35
37
39
41
43
45
47
49

2
4
6
8
10
12
14
16
18
20
22
24
26
28
30
32
34
36
38
40
42
44
46
48
50

SCXI-1521/B User Manual

Signal Name

Pin Number

Pin Number

Signal Name

AI GND

1

2

AI GND

AI 0 +

3

4

AI 0 –

—

5

6

—

—

7

8

—

—

9

10

—

—

11

12

—

—

13

14

—

—

15

16

—

—

17

18

—

OUT REF

19

20

—

—

21

22

—

—

23

24

DIG GND

SER DAT IN

25

26

SER DAT OUT

DAQ D*/A

27

28

—

SLOT 0 SEL*

29

30

—

—

31

32

—

DIG GND

33

34

—

—

35

36

AI HOLD COMP, AI HOLD

SER CLK

37

38

—

—

39

40

—

—

41

42

—

—

43

44

—

—

45

46

SYNC

—

47

48

—

—

49

50

—
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In multiplexed mode, the AI 0 signal pair is used for sending all
24 channels of the SCXI-1521/B, and analog signals from other modules,
to the connected E/M Series DAQ device. If the module is cabled directly
to the E/M Series DAQ device, the other analog channels of the E/M Series
DAQ device are unavailable for general-purpose analog input because they
are connected to active signals on the SCXI-1521/B amplifier.
Table 2-3 lists the communication signals between the E/M Series DAQ
device and the SCXI system. If the E/M Series DAQ device is connected to
the SCXI-1521/B, these digital lines are unavailable for general-purpose
digital I/O.
Table 2-3. SCXI-1521/B Communication Signals

Pin

SCXI Signal
Name

NI-DAQmx
Device Signal
Name

Direction

Description

24, 33

DIG GND

D GND

—

Digital ground—These pins supply
the reference for E/M Series DAQ
device digital signals and are
connected to the module digital
ground.

25

SER DAT IN

P0.0

Input

Serial data in—This signal taps into
the SCXIbus MOSI line to send
serial input data to a module or
Slot 0.

26

SER DAT
OUT

P0.4

Output

27

DAQ D*/A

P0.1

Input

Board data/address line—This
signal taps into the SCXIbus D*/A
line to indicate to the module
whether the incoming serial stream
is data or address information.

29

SLOT 0 SEL*

P0.2

Input

Slot 0 select—This signal taps into
the SCXIbus INTR* line to indicate
whether the information on MOSI
is being sent to a module or Slot 0.
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Table 2-3. SCXI-1521/B Communication Signals (Continued)

NI-DAQmx
Device Signal
Name

Pin

SCXI Signal
Name

36

SCAN CLK

AI HOLD COMP,
AI HOLD

Input

Scan clock—A rising edge
indicates to the scanned SCXI
module that the E/M Series DAQ
device has taken a sample and
causes the module to advance
channels.

37

SER CLK

EXTROBE*

Input

Serial clock—This signal taps into
the SCXIbus SPI CLK line to clock
the data on the MOSI and MISO
lines.

SCXI-1521/B User Manual

Direction

2-6

Description

ni.com

3

Configuring and Testing

This chapter describes how to configure the SCXI-1521/B in MAX for use
with NI-DAQmx. It also describes how to create and test a virtual channel,
global channel, and/or task.

SCXI-1521/B Software Configurable Settings
This section describes how to set the voltage excitation level, and
gain/input signal range, as well as how to use configuration utilities in
MAX to programmatically perform offset null compensation and shunt
calibration. It also describes how to perform configuration of these settings
for the SCXI-1521/B in NI-DAQmx. For more information about the
relationship between the settings and the measurements and how to
configure settings in your application, refer to Chapter 4, Theory of
Operation.

Common Software-Configurable Settings
This section describes the most frequently used software configurable
settings for the SCXI-1521/B. Refer to Chapter 4, Theory of Operation, for
a complete list of software configurable settings.

Bridge Configuration
Bridge configuration is a software configurable setting that allows you to
easily configure the bridge type. The SCXI-1521/B only supports the
quarter-bridge I strain-gauge bridge configuration.

Excitation Level
Excitation level is a software configurable setting that allows you to set the
excitation voltage level of the module. You can choose voltage excitation
settings between 0 and 5 V in 1,023 increments.
Refer to Appendix A, Specifications, for more information about the
excitation voltage settings on the SCXI-1521/B.
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Gain/Input Range
Gain/input range is a software-configurable setting that allows you to
choose the appropriate amplification for your application. The
SCXI-1521/B has a fixed gain of 42 V/V. Additional gain settings are
available on the digitizer device. In most applications NI-DAQmx selects
the gain for you based on the specified input range.

Fine Null Potentiometer
The fine null potentiometer has software configurable settings that allow
you to remove unwanted offset voltage. In most cases, you do not explicitly
set the fine null potentiometer, but instead allow driver software to
automatically adjust it for you. However, if you want to explicitly set the
fine null potentiometer, you can write an application program that adjusts
the fine null potentiometer settings. Refer to Chapter 4, Theory of
Operation, for more information.

Shunt Calibration Switches
The SCXI-1521/B includes a software controllable shunt calibration switch
on each channel of the module that is used to engage or disengage a fixed
shunt calibration resistor.
The gain adjustment is done for you automatically if you have performed shunt
calibration using the NI-DAQ driver. Refer to the NI-DAQmx section for more information
about how to perform shunt calibration using the driver.

Note

Modes of Operation
The SCXI-1521/B operates in multiplexed mode only.

Configurable Settings in MAX
If you are using an NI ADE prior to version 7.0, are using an unlicensed copy of an
NI ADE, or are not using an NI ADE, additional dialog boxes from the NI License
Manager appear allowing you to create a task or global channel in unlicensed mode. These
messages continue to appear until you install version 7.0 or later of an NI ADE.

Note

This section describes where to access each software-configurable setting
for modification in MAX. The location of the settings varies depending on
the version of NI-DAQ you use. Refer to the NI-DAQmx section for more
information about setting locations.
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NI-DAQmx
All software configurable settings are not configurable both ways. This section only
discusses settings in MAX. Refer to Chapter 4, Theory of Operation, for information about
using functions in your application.

Note

Strain and custom voltage with excitation are the most commonly used
NI-DAQmx task or NI-DAQmx Global Channel types with the
SCXI-1521/B. The following list describes the settings you can use in
MAX and where they are located:
•

Voltage excitation—configure using either NI-DAQmx Task or
NI-DAQmx Global Channel. You can also set the voltage excitation
level through your application. In NI-DAQmx, you can choose from
contiguous voltages between 0 and 5 V. The default voltage excitation
in NI-DAQmx is 0 V.

•

Input signal range—configure the input signal range using either
NI-DAQmx Task or NI-DAQmx Global Channel. When you set the
minimum and maximum range of NI-DAQmx Task or NI-DAQmx
Global Channel, the driver selects the best gain for the measurement.

•

Calibration settings—fine null potentiometer settings and control
shunt calibration switches only using Strain NI-DAQmx Task,
Strain NI-DAQmx Global Channel, or your application. The
Custom Voltage with Excitation NI-DAQmx Task or NI-DAQmx
Global Channel cannot adjust calibration settings in MAX. Adjust
calibration settings in your application. The default configuration
settings set the fine null potentiometer to 2,048, which is its midrange
value. The default state of the shunt calibration switches is open. This
state leaves the shunt calibration resistor disconnected from the circuit.

•

Modes of operation—refer to Chapter 1, About the SCXI-1521/B, for
more information about chassis installation. The default setting in
NI-DAQmx is multiplexed.

Creating a Strain Global Channel or Task
To create a new NI-DAQmx strain global task or channel, complete the
following steps:
1.

Launch MAX.

2.

Right-click Data Neighborhood, and select Create New.

3.

Select NI-DAQmx Task or NI-DAQmx Global Channel, and click
Next.

4.

Select Analog Input.

© National Instruments Corporation
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5.

Select Strain.

6.

If you are creating a task, you can select a range of channels by holding
down the <Shift> key while selecting the channels. You can select
multiple individual channels by holding down the <Ctrl> key while
selecting channels. If you are creating a channel, you can only select
one channel. Click Next.

7.

Name the task or channel, and click Finish.

8.

In the box labelled Channel List, select the channel(s) you want to
configure. You can select a range of channels by holding down the
<Shift> key while selecting the channels. You can select multiple
individual channels by holding down the <Ctrl> key while selecting
channels.

To add channels from another module measuring strain, first complete the task
creation for one module, and then in the Channel List, select the + to add channels to the
strain task. Add the additional channels to your task. To add channels of various
measurement types to the same task, you must complete this task in your application. Refer
to the Developing Your Application in NI-DAQmx section of Chapter 5, Using the
SCXI-1521/B, for more information about adding channels.
Note

9.

Enter the specific values for your application in the Settings tab.
Context help information for each setting is provided on the right side
of the screen.

10. Ensure that you have selected the strain channel(s) you wish to
calibrate in the Channel List box. Click Calibration to calibrate the
strain channel(s).
11. On the screen that opens, choose to enable offset nulling and/or shunt
calibration. Enter the shunt calibration resistor information. Click
Next.
12. Measure and Calibrate displays information specific to the strain
channel(s). Click Measure to acquire a signal from the strain
channel(s) and Reset Data to reset the values to default. Click
Calibrate to calibrate the strain channel(s). When you have completed
calibrating the strain channel(s), click Finish.
13. If you are creating a task and want to set timing or triggering controls,
enter the values in the Task Timing and Task Triggering tabs.
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Verifying the Signal
This section describes how to take measurements using test panels in order
to verify signal, and configuring and installing a system in NI-DAQmx.

Verifying the Signal in NI-DAQmx Using a Task or Global Channel
Complete the following steps to verify the SCXI-1521/B signals:
1.

Open the channel or task you created in the Creating a Strain Global
Channel or Task section.

2.

Click the Test button.

© National Instruments Corporation
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This chapter discusses strain-gauge concepts and the theory of operational
measurement concepts.

Strain-Gauge Theory
This section describes how to arrange, connect, and scale signals from
bridge-based sensors—especially strain gauges.

Wheatstone Bridges
All strain-gauge configurations are based on the concept of a Wheatstone
bridge. A Wheatstone bridge is a network of four resistive legs. One or
more of these legs can be an active sensing element. Figure 4-1 shows a
Wheatstone bridge circuit diagram.

VEX +
R4

R1
– VCH +
R2

R3

Figure 4-1. Basic Wheatstone Bridge Circuit Diagram

The Wheatstone bridge is the electrical equivalent of two parallel voltage
divider circuits. R1 and R2 compose one voltage divider circuit, and R4 and
R3 compose the second voltage divider circuit. The output of a Wheatstone
bridge is measured between the middle nodes of the two voltage dividers.
A physical phenomenon, such as a change in strain or temperature applied
to a specimen, changes the resistance of the sensing elements in the
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Wheatstone bridge. The Wheatstone bridge configuration is used to help
measure the small variations in resistance that the sensing elements
produce in response to a physical changes in the specimen.

Acronyms, Formulas, and Variable Definitions
In the figures and equations in this document, the acronyms, formulas, and
variables are defined as:
ε is the measured strain (+ε is tensile strain and –ε is compressive strain).
εS is the simulated strain.
GF is the Gauge Factor, which should be specified by the gauge
manufacturer.
Rg is the nominal gauge resistance, which should be specified by the gauge
manufacturer.
RL is the lead resistance. If lead lengths are long, RL can significantly affect
measurement accuracy.
Rs is the shunt calibration resistor value.
U is the ratio of expected signal voltage to excitation voltage with the shunt
calibration circuit engaged. Parameter U appears in the equations for
simulated strain and is defined by the following equation:
–Rg
U = ----------------------4R s + 2R g
ν is the Poisson’s ratio, defined as the negative ratio of transverse strain to
axial strain (longitudinal) strain. Poisson’s ratio is a material property of the
specimen you are measuring.
VCH is the measured voltage of the signal.
VEX is the excitation voltage.
Vr is the voltage ratio that is used in the voltage to strain conversion
equations and is defined by the following equation:
V CH ( strained ) – V CH (unstrained)
V r =  -----------------------------------------------------------------------------

V EX
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Software Scaling and Equations
Once you have acquired the voltage signal VCH , you can scale this voltage
to the appropriate strain units in software. This is done automatically for
you in NI-DAQmx using a strain task or strain channel. You can also scale
the voltages manually in your application using the voltage to strain
conversion equations provided in this document for each configuration
type.
Finally, voltage to strain conversion functions are included in LabVIEW
and NI-DAQmx. In LabVIEW, the conversion function, Convert Strain
Gauge Reading.vi, is in the Data Acquisition»Signal Conditioning
subpalette. The prototypes for the NI-DAQ functions, Strain_Convert
and Strain_Buf_Convert, are in the header file convert.h for C/C++,
and convert.bas for Visual Basic.
The names of the strain-gauge types in these sections directly correspond
to bridge selections in MAX and the LabVIEW Convert Strain Gauge
Reading VI.

Quarter-Bridge Type I
This section provides information about the quarter-bridge strain-gauge
configuration type I. The quarter-bridge type I measures either axial or
bending strain. Figure 4-2 shows how to position a strain-gauge resistor in
an axial and bending configurations. Figure 4-3 shows the quarter-bridge
type I circuit wiring diagram.

R4 (+ )

R4 (+ )

Axial

Bending

Figure 4-2. Quarter-Bridge Type I Measuring Axial and Bending Strain

A quarter-bridge type I has the following characteristics:
•

A single active strain-gauge element is mounted in the principle
direction of axial or bending strain.

•

A passive quarter-bridge completion resistor (dummy resistor) is
required in addition to half-bridge completion.
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•

Temperature variation in specimen decreases the accuracy of the
measurements.

•

Sensitivity at 1000 µε, where GF = 2.0, is ∼ 0.5 mVout /VEX input.

RL
R1

VEX

+

–

–

VCH

R2

RL

+

R3

R4 (+ )

RL

Figure 4-3. Quarter-Bridge Type I Circuit Diagram

The following symbols apply to the circuit diagram and equations:
R1 and R2 are half-bridge completion resistors.
R3 is the quarter-bridge completion resistor (dummy resistor).
R4 is the active strain-gauge element measuring tensile strain (+ε).
VEX is the excitation voltage.
RL is the lead resistance.
VCH is the measured voltage.
Vr is the voltage ratio that is used in the voltage to strain conversion
equations and is defined by the following equation:
V CH ( strained ) – V CH (unstrained)
V r =  -----------------------------------------------------------------------------

V EX
To convert voltage readings to strain units use, the following equation:
R
–4 Vr
×  1 + -----L- 
strain ( ε ) = ------------------------------GF ( 1 + 2V r ) 
Rg 
where

Rg is the nominal gauge resistance of the sensor.
RL is the lead resistance.
GF is the Gauge Factor.

SCXI-1521/B User Manual

4-4

ni.com

Chapter 4

Theory of Operation

To simulate the effect on strain of applying a shunt resistor across R3, use
the following equation:
– 4U
ε s = ----------------------------GF ( 1 + 4U )
Notes To minimize temperature drift errors, the strain gauge must have a

self-temperature-compensation (STC) number that corresponds to the thermal expansion
coefficient of the material under test. STC gauges have a temperature sensitivity that
counteracts the thermal expansion coefficient of the test specimen. The STC number
approximately equals the thermally induced change in strain with change in temperature
and is expressed in units of microstrain per degree Fahrenheit. For example, if the test
specimen is aluminum, use a gauge with an STC number of 13.0. If the test specimen is
steel, use a gauge with an STC number of 6.0.
You can neglect lead resistance (RL) of the wiring if shunt calibration is performed or if lead
length is very short (∼ <10 ft), depending on the wire gauge. For example 10 ft of 24-AWG
copper wire has a lead resistance of 0.25 Ω.

SCXI-1521/B Theory of Operation
This section includes a brief overview and a detailed discussion of the
circuit features of the module. Refer to Figure 4-4 while reading this
section.
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Completion

Figure 4-4. Block Diagram of SCXI-1317 and SCXI-1521/B Combination
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The SCXI-1521/B input terminals consist of three terminals per channel for
direct connectivity to 3-wire resistive strain gauges. EX+ connects to the
voltage excitation, QTR connects to the SCXI-1521/B quarter-bridge
completion resistor, and AI connects to the SCXI-1521/B AI input
amplifier. Figure 4-4 shows the block diagram of the SCXI-1521/B.
The input amplifier stage provides amplification and presents a high input
impedance to external signals. The offset null compensation circuitry is
used to null offset voltages that result from initial imbalances in the
strain-gauge bridge connection.
The input amplification stage is followed by an additional amplification
and lowpass filter stage before reaching the output multiplexer.
The SCXI-1521/B has a fixed lowpass filter with a 3 dB cutoff of 10 Hz.
The SCXI-1521/B has a fixed gain of 42 V/V.
The signal then passes to the multiplexer stage. The modes of operation are
determined by the multiplexer stage. The signal is routed to the E/M Series
DAQ device channel 0 if the SCXI-1521/B is the cabled module and/or to
the SCXI backplane through the SCXIbus connector.
Note

The SCXI-1521/B does not support parallel mode.
The multiplexer stage is controlled by the digital interface and control
circuitry. The digital interface and control circuitry stores the scan list,
controls the multiplexer, and allows flexible scanning (random scanning).
The shunt calibration circuitry is comprised of a fixed value shunt resistor
in series with a switch. The switch is controlled by the digital interface and
control circuity. When the switch is closed, the shunt calibration resistor is
connected in parallel with the quarter-bridge completion resistor.
For more detailed information about the operation of any of these circuitry
stages, refer to the Quarter-Bridge Completion, Excitation, Offset Null
Compensation, Shunt Calibration, and Modes of Operation sections.

Quarter-Bridge Completion
Quarter-bridge completion resistors are provided on the module. The
SCXI-1521 has 350 Ω resistors, while the SCXI-1521B has 120 Ω
resistors.
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Excitation
You can set the excitation voltage of the SCXI-1521/B from 0 to 5 V in
1,023 steps. The excitation voltage is buffered on a per channel basis to
prevent excitation load variation errors from interfering with other
channels. You can set the excitation voltage in banks of six channels
grouped as follows: CH <0..5>, CH <6..11>, CH <12..17>, and
CH <18..23>.
Refer to the Configurable Settings in MAX section of Chapter 3,
Configuring and Testing, for more information about programmatically
setting excitation level in MAX. For more information about
programmatically setting excitation level in NI-DAQmx, refer to the
Developing Your Application in NI-DAQmx section of Chapter 5, Using the
SCXI-1521/B.

Offset Null Compensation
The SCXI-1521/B provides hardware offset null compensation that
removes the offset voltage that exists in the strain gauge when it is
unstrained to adjust signal voltages to proper levels. Hardware offset
nulling is performed programmatically using software.
The fine null potentiometer is used for offset adjustments. The
potentiometer signals are added to the analog input path to adjust the signal
voltage to remove the offset, which nulls the strain-gauge channel. The
voltage input to the potentiometer is a voltage proportional to the excitation
voltage setting. Therefore, if the excitation voltage changes by a small
amount due to a changes such as temperature and sensor loading, the
correction signal produced by the fine null potentiometer changes by the
same amount and the offset null is maintained.
The fine null potentiometer is controlled digitally using control codes. The
control codes of the fine null potentiometer are set in software using integer
values. Table 4-1 summarizes the nulling range and scale of the control
codes.
Table 4-1. Control Codes for Fine Null Potentiometers

SCXI-1521/B User Manual
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Mid-Scale

Bridge Offset Nulling

0 to 4,095

2,048

±0.45% of VEX
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In most cases, you do not explicitly set the fine null potentiometer, but
instead allow the NI-DAQ driver software to automatically adjust it for you.
You can do this either through MAX or in your application.
Refer to the Configurable Settings in MAX section of Chapter 3,
Configuring and Testing, for more information about programmatically
performing offset null compensation in MAX. For more information about
programmatically performing offset null compensation in NI-DAQmx,
refer to the Developing Your Application in NI-DAQmx section of
Chapter 5, Using the SCXI-1521/B.

Shunt Calibration
Shunt calibration is a process used to obtain a gain adjust factor, which is
used to correct for system gain error.
The gain adjust factor is derived using theoretical (simulated) signal levels
that should result from engaging a shunt resistor across one leg of a bridge
sensor and the measured signal levels with the shunt resistor actually
engaged.
Use the following formula to calculate the gain adjust factor:
simulated signal level
gain adjust factor = -----------------------------------------------------------------------------------------------------------------------measured signal level with shunt resistor engaged
The gain adjust factor is then multiplied by each future measurement to
obtain accurate measurements that are adjusted for gain errors. Refer to the
Configurable Settings in MAX section of Chapter 3, Configuring and
Testing, for more information about performing shunt calibration
automatically in global channels using NI-DAQmx in MAX. For more
information about programmatically performing shunt calibration in
NI-DAQmx, refer to the Developing Your Application in NI-DAQmx
section of Chapter 5, Using the SCXI-1521/B.
Perform an offset null compensation just before you perform a shunt calibration.
Performing a shunt calibration before an offset null compensation causes improper gain
adjustment because the offset signal voltage is compensated multiple times.

Note

Modes of Operation
The SCXI-1521/B operates in multiplexed mode, passing the conditioned
signals to the digitizing DAQ device.
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Theory of Multiplexed Mode Operation
In multiplexed mode, all input channels of an SCXI module are multiplexed
into a single analog input channel of the DAQ device. Multiplexed mode
operation is ideal for high channel count systems. Multiplexed mode is
typically used for performing scanning operations with the SCXI-1521/B.
The power of SCXI multiplexed mode scanning is its ability to route many
input channels to a single channel of the DAQ device.
The multiplexing operation of the analog input signals is performed
entirely by multiplexers in the SCXI modules, not inside the DAQ device
or SCXI chassis. In multiplexed mode the SCXI-1521/B scanned channels
are kept by the NI-DAQ driver in a scan list. Immediately prior to a
multiplexed scanning operation, the SCXI chassis is programmed with a
module scan list that controls which module sends its output to the
SCXIbus during a scan through the cabled SCXI module.
The list can contain channels in any physical order and the multiplexer can
sequence the channel selection from the scan list in any order. The ordering
of scanned channels need not be sequential. Channels can occur multiple
times in a single scan list. The scan list can contain an arbitrary number of
channels for each module entry in the scan list, limited to a total of
512 channels per DAQ device. This is referred to as flexible scanning
(random scanning). Not all SCXI modules provide flexible scanning.
The module includes first-in first-out (FIFO) memory for storing the
channel scan list defined in your application code. NI-DAQ drivers load the
FIFO based on the channel assignments you make in your application. You
need not explicitly program the module FIFO as this is done automatically
for you by the NI-DAQ driver.
When you configure a module for multiplexed mode operation, the routing of
multiplexed signals to the DAQ device depends on which module in the SCXI
system is cabled to the DAQ device. There are several possible scenarios for
routing signals from the multiplexed modules to the DAQ device.
If the scanned SCXI-1521/B module is not directly cabled to the DAQ
device, the module sends its signals through the SCXIbus to the cabled
module. The cabled module, whose routing is controlled by the SCXI
chassis, routes the SCXIbus signals to the DAQ device through the AI 0 pin
on its rear signal connector.
If the DAQ device scans the cabled module, the module routes its input
signals through the AI 0 pin on its rear signal connector to the DAQ
device AI 0.
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This chapter makes suggestions for developing your application and
provides basic information regarding calibration.

Developing Your Application in NI-DAQmx
If you are using an NI ADE prior to version 7.0, using an unlicensed copy of an
NI ADE, or not using an NI ADE, additional dialog boxes from the NI License Manager
appear allowing you to create a task or global channel in unlicensed mode. These messages
continue to appear until you install version 7.0 or later of an NI ADE.

Note

This section describes how to configure and use NI-DAQmx to control the
SCXI-1521/B in LabVIEW, LabWindows/CVI, and Measurement Studio.
These ADEs provide greater flexibility and access to more settings than
MAX, but you can use ADEs in conjunction with MAX to quickly create a
customized application.

Typical Program Flowchart
Figure 5-1 shows a typical program flowchart for creating a task to
configure channels, take a measurement, analyze the data, present the data,
stop the measurement, and clear the task.

© National Instruments Corporation
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Figure 5-1. Typical Program Flowchart
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General Discussion of Typical Flow Chart
The following sections briefly discuss some considerations for a few of the
steps in Figure 5-1. These sections are meant to give an overview of some
of the options and features available when programming with NI-DAQmx.

Creating a Task Using DAQ Assistant or
Programmatically
When creating an application, you must first decide whether to create the
appropriate task using the DAQ Assistant or programmatically in the ADE.
Developing your application using DAQ Assistant gives you the ability to
configure most settings such as measurement type, selection of channels,
excitation voltage, signal input limits, task timing, and task triggering. You
can access the DAQ Assistant through MAX or your NI ADE. Choosing to
use the DAQ Assistant can simplify the development of your application.
NI recommends creating tasks using the DAQ Assistant for ease of use,
when using a sensor that requires complex scaling, or when many
properties differ between channels in the same task.
If you are using an ADE other than an NI ADE, or if you want to explicitly
create and configure a task for a certain type of acquisition, you can
programmatically create the task from your ADE using functions or VIs. If
you create a task using the DAQ Assistant, you can still further configure
the individual properties of the task programmatically with functions or
property nodes in your ADE. NI recommends creating a task
programmatically if you need explicit control of programmatically
adjustable properties of the DAQ system.
Programmatically adjusting properties for a task created in the DAQ
Assistant overrides the original, or default, settings only for that session.
The changes are not saved to the task configuration. The next time you load
the task, the task uses the settings originally configured in the DAQ
Assistant.

Adjusting Timing and Triggering
There are several timing properties that you can configure through the
DAQ Assistant or programmatically using function calls or property nodes.
If you create a task in the DAQ Assistant, you can still modify the timing
properties of the task programmatically in your application.
When programmatically adjusting timing settings, you can set the task to
acquire continuously, acquire a buffer of samples, or acquire one point at a
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time. For continuous acquisition, you must use a while loop around the
acquisition components even if you configured the task for continuous
acquisition using MAX or the DAQ Assistant. For continuous and buffered
acquisitions, you can set the acquisition rate and the number of samples to
read in the DAQ Assistant or programmatically in your application. By
default, the clock settings are automatically set by an internal clock based
on the requested sample rate. You can also select advanced features such as
clock settings that specify an external clock source, internal routing of the
clock source, or select the active edge of the clock signal.

Configuring Channel Properties
All ADEs used to configure the SCXI-1521/B access an underlying set of
NI-DAQmx properties. Table 5-1 shows some of these properties. You can
use Table 5-1 to determine what kind of properties you need to set to
configure the module for your application. For a complete list of
NI-DAQmx properties, refer to your ADE help file.
You cannot adjust some properties while a task is running. For these properties, you
must stop the task, make the adjustment, and re-start the application. Figure 5-1 assumes
all properties are configured before the task is started.

Note

Table 5-1. NI-DAQmx Properties

Property

Short Name

Description

Analog Input»General Properties»
Advanced»Range»High

AI.Rng.High

Specifies the upper limit
of the input range

Analog Input»General Properties»
Advanced»Range»Low

AI.Rng.Low

Specifies the lower limit
of the input range

Analog Input»General Properties»
Signal Conditioning»Bridge»
Shunt Cal»Shunt Cal Enable

AI.Bridge.ShuntCal.Enable

Specifies whether to place
the shunt calibration
resistor across one arm of
the bridge

Analog Input»General Properties»
Signal Conditioning»Excitation»
Value

AI.Excit.Val

Specifies the amount of
excitation in volts

Analog Input»General Properties»
Signal Conditioning»Bridge»
Nominal Resistance

AI.Bridge.NomResistance

Specifies in ohms the
resistance of the bridge in
an unloaded condition

SCXI-1521/B User Manual

5-4

ni.com

Chapter 5

Using the SCXI-1521/B

Table 5-1. NI-DAQmx Properties (Continued)

Property

Short Name

Description

Analog Input»Strain»Strain Gage»
Gage Factor

AI.StrainGage.GageFactor

Specifies the sensitivity
of the strain gauge

Analog Input»Strain»Strain Gage»
Poisson Ration

AI.StrainGage.PoissonRatio

Specifies the ratio of
lateral strain to axial
strain in the specimen
material

Analog Input»General Properties»
Signal Conditioning»Bridge»
Initial Bridge Voltage

AI.Bridge.InitialVoltage

Specifies in volts the
output voltage of the
bridge in the unloaded
condition

Analog Input»General Properties»
Signal Conditioning»Bridge»
Balance»Fine Potentiometer
Property

AI.Bridge.Balance.FinePot

Specifies by how much to
compensate for offset in
the signal. This value can
be between 0 and 4,095.

Analog Input»General Properties»
Signal Conditioning»Excitation»
Source

AI.Excit.Src

Specifies the source of
excitation

Note This is not a complete list of NI-DAQmx properties and does not include every
property you may need to configure your application. It is a representative sample of
important properties to configure for strain measurements. For a complete list of
NI-DAQmx properties and more information about NI-DAQmx properties, refer to your
ADE help file.

Perform Offset Null Compensation
The SCXI-1521/B provides offset null compensation circuitry to adjust
signal voltages to proper levels when the strain gauge is at rest (unstrained).
You can use a strain task or global channel to perform offset null
compensation. The offset null compensation is performed during the
configuration of the global channel(s). Refer to the Creating a Strain
Global Channel or Task section of Chapter 3, Configuring and Testing,
for information about offset null compensation when in MAX.
For more information about offset null compensation, refer to the Offset
Null Compensation section of Chapter 4, Theory of Operation.

© National Instruments Corporation
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Perform Shunt Calibration
Shunt calibration is a process used to obtain a gain adjust factor, which
corrects for system gain error. You can use a strain task or global channel
to perform shunt calibration. The shunt calibration is performed during the
configuration of the global channel(s). Refer to the Creating a Strain
Global Channel or Task section of Chapter 3, Configuring and Testing, for
information about shunt calibration in MAX.
To manually perform shunt calibration, refer to the Shunt Calibration
section of Chapter 4, Theory of Operation.

Acquiring, Analyzing, and Presenting
After configuring the task and channels, you can start the acquisition, read
measurements, analyze the data returned, and display it according to the
needs of your application. Typical methods of analysis include digital
filtering, averaging data, performing harmonic analysis, applying a custom
scale, or adjusting measurements mathematically.
Some custom scaling applications require the actual excitation voltage
applied to the bridge instead of the nominal excitation voltage output by the
SCXI-1521/B.
NI provides powerful analysis toolsets for each NI ADE to help you
perform advanced analysis on the data without requiring you to have a
programming background. After you acquire the data and perform any
required analysis, it is useful to display the data in a graphical form or log
it to a file. NI ADEs provide easy to use tools for graphical display, such as
charts, graphs, slide controls, and gauge indicators. NI ADEs have tools
that allow you to easily save the data to files such as spread sheets for easy
viewing, ASCII files for universality, or binary files for smaller file sizes.

Completing the Application
After you have completed the measurement, analysis, and presentation of
the data, it is important to stop and clear the task. This releases any memory
used by the task and frees up the DAQ hardware for use in another task.
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Developing an Application Using LabVIEW
This section describes in more detail the steps shown in the typical program
flowchart in Figure 5-1, such as how to create a task in LabVIEW and
configure the channels of the SCXI-1521/B. If you need more information
or for further instructions, select Help»VI, Function, & How-To Help
from the LabVIEW menu bar.
Except where otherwise stated, the VIs in Table 5-2 are located on the Functions»
All Functions»NI Measurements»DAQmx - Data Acquisition subpalette and
accompanying subpalettes in LabVIEW.
Note

Table 5-2. Programming a Task in LabVIEW

Flowchart Step

VI or Program Step

Create Task in DAQ Assistant

Create a DAQmx Task Name Constant located on the
Controls»All Controls»I/O»DAQmx Name Controls
subpalette, right-click it, and select New Task (DAQ
Assistant).

Create a Task
Programmatically
(optional)

DAQmx Create Task.vi—This VI is optional if you created

Create AI Strain Channel
(optional)

DAQmx Create Virtual Channel.vi (AI Voltage by default,
to change to a strain gauge channel click AI Voltage and select
Analog Input»Strain»Strain Gage.)—This VI is optional if
you created and configured your task and channels using the
DAQ Assistant. Any channels created with this VI are not saved
in the task in the DAQ Assistant, they are only available for the
present session.

or
Create AI Custom Voltage
with Excitation Channel
Adjust Timing Settings
(optional)

© National Instruments Corporation

and configured your task using the DAQ Assistant. However, if
you use it in LabVIEW any changes you make to the task will not
be saved to a task in MAX.

DAQmx Timing.vi (Sample Clock by default)—This VI is

optional if you created and configured your task using the DAQ
Assistant. Any timing settings modified with this VI are not
saved in the task in the DAQ Assistant, they are only available for
the present session.
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Table 5-2. Programming a Task in LabVIEW (Continued)

Flowchart Step

VI or Program Step

Configure Channels
(optional)

DAQmx Channel Property Node, refer to the Using a DAQmx
Channel Property Node in LabVIEW section for more
information. This step is optional if you created and fully
configured the channels in your task using the DAQ Assistant.
Any channel modifications made with a channel property node
are not saved in the task in the DAQ Assistant, they are only
available for the present session.

Perform Offset Null
Compensation

You can perform offset null compensation when you create and
configure your channels using the DAQ Assistant. Refer to the
Creating a Strain Global Channel or Task section of Chapter 3,
Configuring and Testing, for information about offset null
compensation in MAX.

Perform Shunt Calibration

You can perform shunt calibration when you create and configure
your channels using the DAQ Assistant. Refer to the Creating a
Strain Global Channel or Task section of Chapter 3, Configuring
and Testing, for information about shunt calibration in MAX.

Start Measurement

DAQmx Start Task.vi

Read Measurement

DAQmx Read.vi

Analyze Data

Some examples of data analysis include filtering, scaling,
harmonic analysis, or level checking. Some data analysis tools
are located on the Functions»Signal Analysis subpalette and on
the Functions»All Functions»Analyze subpalette.

Display Data

You can use graphical tools such as charts, gauges, and graphs to
display your data. Some display tools are located on the
Controls»Numeric Indicators subpalette and Controls»
All Controls»Graph subpalette.

Continue Sampling

For continuous sampling, use a While Loop. If you are using
hardware timing, you also need to set the DAQmx Timing.vi
sample mode to Continuous Samples. To do this right-click the
terminal of the DAQmx Timing.vi labeled sample mode and
click Create»Constant. Click the box that appears and select
Continuous Samples.

Stop Measurement

DAQmx Stop Task.vi (This VI is optional, clearing the task
automatically stops the task.)

Clear Task

DAQmx Clear Task.vi
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Using a DAQmx Channel Property Node in LabVIEW
You can use property nodes in LabVIEW to manually configure the
channels. To create a LabVIEW property node, complete the following
steps:
1.

Launch LabVIEW.

2.

Create the property node in a new VI or in an existing VI.

3.

Open the block diagram view.

4.

From the Functions toolbox, select All Functions»
NI Measurements»DAQmx - Data Acquisition, and select
DAQmx Channel Property Node.

5.

Left-click inside the box labelled Property, and select Active
Channels. This allows you to specify exactly what channel(s) you
want to configure. If you want to configure several channels with
different properties, separate the lists of properties with another Active
Channels box and assign the appropriate channel to each list of
properties.

Note If you do not use Active Channels, the properties are set on all of the channels in
the task.

6.

Right-click ActiveChans, and select Add Element. Left-click the new
ActiveChans box. Navigate through the menus, and select the
property you wish to define.

7.

Change the property to read or write to either get the property or write
a new value. Right-click the property, go to Change To, and select
Write, Read, or Default Value.

8.

After you have added the property to the property node, right-click the
terminal to change the attributes of the property, add a control,
constant, or indicator.

9.

To add another property to the property node, right-click an existing
property and left-click Add Element. To change the new property,
left-click it and select the property you wish to define.

Note Refer to LabVIEW Help for information about property nodes and specific
NI-DAQmx properties.

© National Instruments Corporation
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Specifying Channel Strings in NI-DAQmx
Use the channel input of DAQmx Create Channel to specify the
SCXI-1521/B channels. The input control/constant has a drop-down menu
showing all available external channels. You can right-click the physical
channel input, select I/O Name Filtering, and check Internal Channels.
This allows you to select the SCXI-1521/B excitation channels. The strings
take one of the following forms:
•

Single device identifier/channel number—for example SC1Mod1/ch0

•

Multiple, noncontinuous channels—for example SC1Mod1/ch0,
SC1Mod1/ch4

•
•

Multiple continuous channels—for example SC1Mod1/ch0:4
(channels 0 through 4)
Excitation on a particular SCXI-1521/B channel—for example
SC1Mod1/_Vex0, SC1Mod1/_Vex1

Once you have a task containing SCXI-1521/B channels, you can set the
properties of the channels programmatically using the DAQmx Channel
Property Node.

Text Based ADEs
You can use text based ADEs such as LabWindows/CVI, Measurement
Studio, Visual Basic, .NET, and C# to create code for using the
SCXI-1521/B.

LabWindows/CVI
LabWindows/CVI works with the DAQ Assistant in MAX to generate
code for a strain task. You can then use the appropriate function call to
modify the task. To create a configurable channel or task in
LabWindows/CVI, complete the following steps:

SCXI-1521/B User Manual

1.

Launch LabWindows/CVI.

2.

Open a new or existing project.

3.

From the menu bar, select Tools»Create/Edit DAQmx Tasks.

4.

Choose Create New Task In MAX or Create New Task In Project
to load the DAQ Assistant.

5.

Configure the NI-DAQmx strain task following the instructions in the
Creating a Strain Global Channel or Task section.

6.

The DAQ Assistant creates the code for the task based on the
parameters you define in MAX and the device defaults. To change a
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property of the channel programmatically, use the
DAQmxSetChanAttribute function.
Refer to NI LabWindows/CVI Help for more information about creating NI-DAQmx
tasks in LabWindows/CVI and NI-DAQmx property information.

Note

Measurement Studio (Visual Basic, .NET, and C#)
When creating a strain task in Visual Basic .NET and C#, follow the
general programming flow in Figure 5-1. You can then use the appropriate
function calls to modify the task. This example creates a new task and
configures an NI-DAQmx strain channel on the SCXI-1521/B. You can use
the same functions for Visual Basic .NET and C#.
Create a new task with the channel object. In this example, an analog input
channel object is used since reading the voltage from a Wheatstone bridge
configuration is an analog input operation. The following text is a function
prototype example:
void AIChannelCollection.CreateStrainGageChannel(
System.String physicalChannelName,
System.String nameToAssignChannel,
System.Double minVal,
System.Double maxVal,
AIStrainGageConfiguration
strainGageConfiguration,
AIExcitationSource excitationSource,
System.Double excitationValue,
System.Double gageFactor,
System.Double initialBridgeVoltage,
System.Double normalGageResist,
System.Double poissonRatio,
System.Double leadWireResist,
AIStrainUnits units);

To actually create and configure the channel, modify the following example
code or the code from one of the shipping examples as needed to suit your
application:
Task myTask = new
NationalInstruments.DAQmx.Task(“myTaskName”);
MyTask.CreateStrainGageChannel (
“SC1Mod1/ai0”, // System.String
physicalChannelName
“strain0”, // System.String nameToAssignChannel
-0.001, // System.Double minVal

© National Instruments Corporation
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0.001, // System.Double maxVal
AIStrainGageConfiguration.QuarterBridgeI, //
AIStrainGageConfiguration
strainGageConfiguration
AIExcitationSource.Internal, //
AIExcitationSource excitationSource
3.3, // System.Double excitationValue
2.0, // System.Double gageFactor
0.0, // System.Double initialBridgeVoltage
120.0, // System.Double normalGageResist
0.3, // System.Double poissonRatio
0.0, // System.Double leadWireResist
AIStrainUnits.Strain); // AIStrainUnits units
// setting attributes after the channel is created
AIChannel myChannel = myTask.AIChannels[“strain0”];
Notes You can create and configure the strain task in MAX and load it into your

application with the function call
NationalInstruments.DAQmx.DaqSystem.Local.LoadTask

Refer to NI Measurement Studio Help for more information about creating NI-DAQmx
tasks in LabWindows/CVI and NI-DAQmx property information.

Other Application Documentation and Material
Refer to the ADE manual and the DAQ analog input examples that come
with your application software for more detailed information about
programming the SCXI modules for scanning in multiplexed mode.

Calibrating the Strain System
There are two types of calibration important to verifying the accuracy of a
strain measurement system. Device calibration ensures the accuracy of the
SCXI-1521/B. System calibration involves removing potential
error-causing variables such as offset and verifying the accuracy of the
strain element through shunt calibration.

SCXI-1521/B User Manual
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Calibrating the SCXI-1521/B
The SCXI-1521/B is shipped with a calibration certificate and is calibrated
at the factory to the specifications described in Appendix A, Specifications.
Calibration constants are stored inside the calibration EEPROM and
provide software correction values your application development software
uses to correct the measurements for errors in the module.

External Calibration
Most external calibration documents for SCXI modules are available to
download from ni.com/calibration by clicking Manual Calibration
Procedures. For external calibration of modules not listed there, Basic
Calibration Service or Detailed Calibration Service is recommended. You
can get information about both of these calibration services from ni.com/
calibration. NI recommends performing an external calibration once a
year.

Calibrating the System
You should perform offset null compensation or shunt calibration on
transducers in the system to improve accuracy. This is considered system,
or end-to-end, calibration.

Offset Null Compensation
Performing an offset null compensation removes offset in the measurement
system. Factors such as imperfections in the strain gauge, electrical offset
in the measurement system, signal leads with significant lead resistance, as
well as other system variables can create offset. Refer to the Offset Null
Compensation section of Chapter 4, Theory of Operation, for information
about how to perform offset null compensation.

Shunt Calibration
Performing shunt calibration removes gain or amplitude errors in the
measurement system. Factors such as non-ideal gauge resistance and
temperature fluctuations, as well as other system variables can create these
errors. Refer to the Shunt Calibration section of Chapter 4, Theory of
Operation, for information about how to perform shunt calibration.

© National Instruments Corporation
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Specifications

This appendix lists the specifications for the SCXI-1521/B modules. These
specifications are typical at 25 °C unless otherwise noted.

Analog Input
Number of channels ............................... 24
Voltage gain ........................................... 42
Input coupling ........................................ DC
Overvoltage protection........................... ±11 V powered on and off
Inputs protected...................................... <AI 0..24>

Transfer
Nonlinearity ........................................... 0.02% max
Gain error
After calibration1............................. 0.1% reading max
Before calibration2 .......................... 4.0% of reading max
Input offset error .................................... 7 mV max
1 mV typ

1

2

This is the error after software correction. Gain error is taken into account in the software correction coefficients stored in the
onboard EEPROM. These constants are applied automatically when using NI-DAQmx.
This is the error before software calibration.
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Dynamic
Minimum scan interval (per channel)
±0.012% accuracy ...........................3 µs
±0.006% accuracy ...........................10 µs
±0.0015% accuracy .........................20 µs
Noise RTI1
0.1 to 10 Hz .....................................2.5 µVpp
>10 Hz .............................................1 µVrms in 1 MHz bandwidth

Filter
Lowpass filter type .................................2-pole Butterworth
(12 dB/octave rolloff)
3 dB bandwidth.......................................10 Hz

Stability
Recommended warm-up time.................30 minutes
Gain drift.................................................±11 ppm/°C max
±4 ppm/°C typ
Offset drift ..............................................±3 µV/°C max
±1 µV/°C typ

Offset Null Compensation
Range ......................................................±0.45% of excitation voltage
Resolution ...............................................4,096 counts of resolution
(±9,600 µε offset null
compensation range, 4.4 µε
resolution for GF = 2.0)

1

Includes excitation voltage noise contribution.
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Excitation
Type ....................................................... Constant voltage
Settings................................................... 0.0 to 5.0 V in 1,023 steps
Error ....................................................... ±20 mV ±0.3% max
Maximum output current ....................... 21 mA
Load regulation (open to 240 Ω)............ 0.08%
Temperature drift ................................... ±0.0025%/°C ±30 µV/°C max
Protection ............................................... Surge arrestors in parallel with
excitation terminals, shunt to
ground, short circuit protected

Bridge Completion
SCXI-1521 ............................................. 350 Ω, 0.1%, 2 ppm/°C max,
55 mW at 50 °C
SCXI-1521 long-term stability............... 0.02%/yr
SCXI-1521B........................................... 120 Ω, 0.1%, 2 ppm/°C max,
55 mW at 50 °C
SCXI-1521 B long-term stability........... 0.02%/yr

Shunt Calibration
Type ....................................................... Shunt across quarter-bridge
completion resistor
Shunt resistor.......................................... Fixed 100 kΩ, 0.1%,
10 ppm/°C, 150 mW
Switch resistance.................................... 15 Ω max
7.5 Ω typ

© National Instruments Corporation
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Power Requirements (from SCXI Backplane)
V+ ...........................................................18.5 to 25 VDC, +170 mA min
V– ...........................................................–18.5 to –25 VDC, –170 mA min
+5 V ........................................................+4.75 to 5.25 VDC, 50 mA min

Physical

3.0 cm
(1.2 in.)

17.2 cm
(6.8 in.)

18.8 cm
(7.4 in.)

Figure A-1. SCXI-1521/B Dimensions

Weight ....................................................748 gm (26.4 oz)
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Maximum Working Voltage
Maximum working voltage refers to the signal voltage plus the
common-mode voltage.
Channel-to-earth..................................... Input should remain within ±11 V
of ground. Measurement
Category I
Channel-to-channel ................................ Input should remain within ±11 V
of ground. Measurement
Category I
Caution

Do not use for measurements within Measurement Categories II, III, or IV.

Environmental
Operating temperature............................ 0 to 50 °C
Storage temperature ............................... –20 to 70 °C
Humidity ................................................ 10 to 90% RH, noncondensing
Maximum altitude .................................. 2,000 m
Pollution Degree (indoor use only) ........ 2

Safety
The SCXI-1521/B is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control, and
laboratory use:
•

IEC 61010-1, EN 61010-1

•

UL 61010-1

•

CAN/CSA-C22.2 No 61010-1

Note For UL and other safety certifications, refer to the product label, or visit
ni.com/certification, search by model number or product line, and click the

appropriate link in the Certification column.

© National Instruments Corporation
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Electromagnetic Compatibility
Emissions................................................EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz
Immunity ................................................EN 61326:1997 + A2:2001,
Table 1
EMC/EMI ...............................................CE, C-Tick, and FCC Part 15
(Class A) Compliant
Note

For EMC compliance, operate this device with shielded cabling.

CE Compliance
The SCXI-1521/B meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:
Low-Voltage Directive (safety)..............73/23/EEC
Electromagnetic Compatibility
Directive (EMC) .....................................89/336/EEC
Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.
Note
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B

This appendix explains how to remove the SCXI-1521/B from MAX and
an SCXI or PXI/SCXI combination chassis.

Removing the SCXI-1521/B from MAX
To remove a module from MAX, complete the following steps after
launching MAX:
1.

Display the list of installed devices and interfaces by clicking
the + next to the Devices and Interfaces icon.

2.

Click the + next to NI-DAQmx Devices to display the chassis.

3.

Click the + next to the appropriate chassis to display the installed
modules.

4.

Right-click the module or chassis you want to delete and click Delete.

5.

You are presented with a confirmation window. Click Yes to continue
deleting the module or chassis or No to cancel this action.

Deleting the SCXI chassis deletes all modules in the chassis. All configuration
information for these modules is also lost.

Note

The SCXI chassis and/or SCXI module(s) should now be removed from the
list of installed devices in MAX.

Removing the SCXI-1521/B from a Chassis
Consult the documentation for the chassis and accessories for additional
instructions and precautions. To remove the SCXI-1521/B module from a
chassis, complete the following steps while referring to Figure B-1:
Figure B-1 shows an SCXI chassis, but the same steps are applicable to a PXI/SCXI
combination chassis.

Note

1.

Power off the chassis. Do not remove the SCXI-1521/B module from
a chassis that is powered on.

2.

If the SCXI-1521/B is the module cabled to the E/M Series DAQ
device, disconnect the cable.
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Removing the SCXI-1521/B

3.

Remove any terminal block that connects to the SCXI-1521/B.

4.

Rotate the thumbscrews that secure the SCXI-1521/B to the chassis
counterclockwise until they are loose, but do not completely remove
the thumbscrews.

5.

Remove the SCXI-1521/B by pulling steadily on both thumbscrews
until the module slides completely out.

7

1

5
4
3
2
1

SC

MA

5

ADDRESS

6

XI

INF
RA

ME

SC
XI
11
00

2
4
3

1
2
3
4

Cable
SCXI Module Thumbscrews
SCXI-1521/B
Strain-Gauge

5
6
7

Terminal Block
SCXI Chassis Power Switch
SCXI Chassis

Figure B-1. Removing the SCXI-1521/B
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Common Questions
This appendix lists common questions related to the use of the
SCXI-1521/B.

Which version of NI-DAQ works with the SCXI-1521/B, and how do I
get the most current version of NI-DAQ?
You must have NI-DAQmx 7.3 or later. Go to ni.com and click Download
Software. Next click Drivers and Updates. In the search field enter
NI-DAQ to find the latest version of NI-DAQ for your operating system.
I have gone over the Verifying and Self-Testing the Installation section of
Chapter 1, About the SCXI-1521/B, yet I still cannot correctly test and
verify that my SCXI-1521/B is working. What should I do now?
Unfortunately, there is always the chance that one or more components in
the system are not operating correctly that requires you to call or email a
technical support representative who can often suggest additional
troubleshooting measures. If requesting technical support by phone, have
the system nearby so you can try these measures immediately. NI contact
information is listed in the Signal Conditioning Technical Support
Information document.
In NI-DAQmx, can I use channels of different measurement types in
the same task?
Yes. You can create channels of various measurement types
programmatically in your application using create channel. With
NI-DAQmx 7.3 or later, you can create a task in MAX that has multiple
measurement types.
Will MAX allow me to configure two SCXI-1521/B modules that are in
the same chassis in the multiplexed mode with two different E/M Series
DAQ devices?
No.
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If the SCXI-1521/B module is not cabled directly to a E/M Series DAQ
device, can I measure conditioned signals for channels 0 through 7 at
the rear connector, for example—using a scope, DMM, or custom
acquisition system?
NI does not support or recommend this usage.
Can I use the unused analog input channels of the E/M Series DAQ
device if I am directly cabled to the SCXI-1521/B—for example, with
the SCXI-1180 feedthrough?
No. E/M Series DAQ device channels 1 through 7 connect to the
conditioned analog outputs of SCXI-1521/B channels 1 through 7.
Can I configure the SCXI-1521/B for use in parallel mode?
No. The SCXI-1521/B does not support parallel mode.
Which digital lines are unavailable on the E/M Series DAQ device if I
am cabled to an SCXI-1521/B module?
Table C-1 shows the digital lines that are used by the SCXI-1521/B for
communication and scanning. These lines are unavailable for
general-purpose digital I/O if the SCXI-1521/B is connected to the
E/M Series DAQ device.
Table C-1. Digital Signals on the SCXI-1521/B

E/M Series
DAQ Device
Signal Name

NI-DAQmx
SCXI Signal Name

50-Pin
Connector

68-Pin
Connector

Direction1

DIO 0

P0.0

25

52

Output

DIO 4

P0.4

26

19

Input

DIO 1

P0.1

27

17

Output

DIO 2

P0.2

29

49

Output

SCAN CLK

AI HOLD COMP,
AI HOLD

36

46

Output

SCXI-1521/B User Manual

C-2

ni.com

Appendix C

Common Questions

Table C-1. Digital Signals on the SCXI-1521/B (Continued)

E/M Series
DAQ Device
Signal Name

1

NI-DAQmx
SCXI Signal Name

50-Pin
Connector

68-Pin
Connector

Direction1

PFI 7/
START SCAN

PFI 7/
AI SAMP CLK,
AI SAMP

46

38

Input

EXTROBE*

EXTROBE*

37

45

Input

With respect to the E/M Series DAQ device.

In LabVIEW, can I use different input limits for the same
SCXI-1521/B physical channel?
Yes. Since the SCXI-1521/B has only one gain, the same value is
programmed each time.
Some SCXI modules permit flexible scanning. Does the SCXI-1521/B
module permit flexible scanning?
Yes. Flexible scanning is described in Chapter 4, Theory of Operation.
Are there any cabling restrictions when using an SCXI-1521/B module
with a plug-in E/M Series DAQ device?
Yes. If a chassis contains an SCXI-1521/B, SCXI-1520, SCXI-1530/1531,
or SCXI-1140 module, at least one of these modules must be the cabled
module. A cabled module is the module connected directly to the
E/M Series DAQ device.
Can I use the SCXI-1521/B with a version of NI-DAQ that works under
the Macintosh Operating System (Mac OS)?
No, as of NI-DAQ 6.6.1. Check the release notes of later versions of
NI-DAQ at ni.com for updates.
Is a register-level programming manual available for the
SCXI-1521/B?
NI does not support register-level programming for the SCXI-1521/B.
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What is the power-on state of the SCXI-1521/B multiplexer, analog bus
switches, and configuration settings?
The multiplexer, analog bus switches, and configuration settings are not in
a known state immediately after power on. All hardware settings are
programmed automatically when beginning an acquisition in LabVIEW or
a test panel in MAX.
Which accessories can I use to connect signals to the front of the
SCXI-1521/B module?
Refer to Chapter 1, About the SCXI-1521/B, for more information.
How do I control the excitation voltage, filter setting, potentiometer
settings, and shunt calibration switches from LabVIEW?
Refer to Chapter 3, Configuring and Testing, for more information.
What should I take into consideration when I take measurements from
sensors with external excitation?
Set the Excitation Source Property to external and Excitation Value
Property to the closest value that matches the external excitation level.
Does the SCXI-1317 terminal block contain a CJC temperature
sensor?
No.
Are there any user-serviceable parts inside the SCXI-1521/B?
No. There are no fuses, multiturn potentiometers, DIP switches, slide
switches, socketed resistors, or jumpers inside the module. Disassembly of
the module for any reason voids its warranty and nullify its calibration.
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Glossary
Symbol

Prefix

Value

µ

micro

10 – 6

m

milli

10 –3

k

kilo

10 3

M

mega

10 6

G

giga

10 9

Numbers/Symbols
%

Percent.

+

Positive of, or plus.

–

Negative of, or minus.

±

Plus or minus.

<

Less than.

/

Per.

°

Degree.

ε

Strain.

εs

Simulated strain.

υ

Poisson’s ratio.

Ω

Ohms.

+ 5 V (signal)

+5 VDC source signal.

© National Instruments Corporation

G-1

SCXI-1521/B User Manual

Glossary

A
A

Amperes.

A/D

Analog-to-digital.

absolute accuracy

The maximum difference between the measured value from a data
acquisition device and the true voltage applied to the input, typically
specified as ± voltage.

AC

Alternating current.

ADC

Analog-to-Digital Converter—An electronic device, often an integrated
circuit, that converts an analog voltage to a digital number.

ADE

Application development environment such as LabVIEW,
LabWindows/CVI, Visual Basic, C, and C++.

AI

Analog input.

AI GND

Analog input ground signal.

AI HOLD COMP,
AI HOLD

Scan clock signal used to increment to the next channel after each
E/M Series DAQ device analog-to-digital conversion.

amplification

A type of signal conditioning that improves accuracy in the resulting
digitized signal by increasing signal amplitude relative to noise.

B
bandwidth

The range of frequencies present in a signal, or the range of frequencies to
which a measuring device can respond.

bridge completion
resistors

Fixed-valued resistors used to complete a wheatstone bridge when fewer
than four of the bridge elements are working strain gauges.

Butterworth filter

A lowpass filter whose characteristics are optimized for maximum flatness
in the passband.

C
C

Celsius.

CE

European emissions control standard.
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channel

Pin or wire lead to which you apply, or from which you read, an analog or
digital signal. Analog signals can be single-ended or differential. For digital
signals, channels are grouped to form ports.

chassis

The enclosure that houses, powers, and controls SCXI modules.

CLK

Clock input signal.

CMRR

Common-Mode Rejection Ratio—A measure of the ability of a differential
amplifier to reject interference from a common-mode signal, usually
expressed in decibels (dB).

CMV

See common-mode voltage.

common-mode voltage

Voltage that appears on both inputs of a differential amplifier.

compressive strain

Strain that results from an object being compressed; has a negative value.

current excitation

A source that supplies the current needed by a sensor for its proper
operation.

cutoff frequency

The frequency that defines the upper end of the passband of a lowpass filter.

D
D/A

Digital-to-analog.

D*/A

Data/Address.

D GND

Digital ground signal.

DAC

D/A Converter—an electronic device, often an integrated circuit, that
converts a digital number into a corresponding analog voltage or current.

DAQ

Data AcQuisition—(1) Collecting and measuring electrical signals from
sensors, transducers, and test probes or fixtures and processing the
measurement data using a computer.
(2) Collecting and measuring the same kinds of electrical signals with A/D
and/or DIO boards plugged into a computer, and possibly generating
control signals with D/A and/or DIO boards in the same computer.

DAQ device

A data acquisition device.
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DAQD*/A

The data acquisition board data/address line signal used to indicate whether
the SER DAT IN pulse train transmitted to the SCXI chassis contains data
or address information.

dB

Decibel—The unit for expressing a logarithmic measure of the ratio of
two signal levels: dB = 20log10 V1/V2, for signals in volts.

DC

Direct current.

device

A plug-in data acquisition board, module, card, or pad that can contain
multiple channels and conversion devices.

differential amplifier

An amplifier with two input terminals, neither of which are connected to a
ground reference, whose voltage difference is amplified.

DIN

Deutsche Industrie Norme (German Industrial Standard).

DIO

Digital input/output.

drivers/driver
software

Software that controls a specific hardware device, such as an E/M Series
DAQ device.

E
EEPROM

Electrically Erasable Programmable Read-Only Memory—ROM that can
be erased with an electrical signal and reprogrammed. Some SCXI modules
contain an EEPROM to store measurement-correction coefficients.

EMC

Electromagnetic compliance.

EMI

Electromagnetic interference.

excitation

Supplying a voltage or current source to energize an active sensor or circuit.

F
FIFO

First-in first-out memory buffer.

filtering

A type of signal conditioning that allows you to remove unwanted
frequency components from the signal you are trying to measure.

flexible scanning

The hardware capability to sequence through channels in a scan list in any
order.
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G
gain

The factor by which a signal is amplified, sometimes expressed in decibels.

gain accuracy

A measure of deviation of the gain of an amplifier from the ideal gain.

gain error

See gain accuracy.

Gauge Factor

For a given strain gauge, is the fractional resistance change relative to the
strain that caused the resistance change. Thus, Gauge Factor is a measure
of strain-gauge sensitivity.

GF

See Gauge Factor.

H
half bridge

A Wheatstone bridge consisting of two active strain gauges and two passive
fixed-valued resistors.

Hz

Hertz—Cycles per second of a periodic signal.

I
I/O

Input/Output—The transfer of data to/from a computer system involving
communications channels, operator interface devices, and/or data
acquisition and control interfaces.

ID

Identifier.

in.

Inch or inches.

input impedance

The measured resistance and capacitance between the input terminals of a
circuit.

instrumentation
amplifier

A very accurate differential amplifier with a high input impedance.
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L
line resistance

The small, but nonzero, resistance of a lead wire that varies with the lead
length and ambient temperature; can cause measurement error if the lead
wire carries excitation current.

lowpass filter

A filter that passes signals below a cutoff frequency while blocking signals
above that frequency.

M
m

Meters.

M

(1) Mega, the standard metric prefix for 1 million or 106, when used with
units of measure such as volts and hertz.
(2) mega, the prefix for 1,048,576, or 220, when used with B to quantify data
or computer memory.

max

Maximum.

maximum working
voltage

The highest voltage with respect to ground that can be applied to an input
terminal without damaging the device. Includes both the signal and
common-mode voltages.

microstrain

The unit of strain measurement usually denoted by µε; one µε represents a
deformation of 10–6, or 0.0001%.

min

(1) Minutes.
(2) Minimum.

MISO

Master-in-slave-out signal.

MOSI

Master-out-slave-in signal.

multiplex

To route one of many input signals to a single output.

multiplexed mode

An SCXI operating mode in which analog input channels are multiplexed
into one module output so that the cabled E/M Series DAQ device has
access to the module’s multiplexed output as well as the outputs of all other
multiplexed modules in the chassis.
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N
NI-DAQ

The driver software needed in order to use NI E/M Series DAQ devices and
SCXI components.

noise

An undesirable electrical signal—Noise comes from external sources such
as AC power lines, motors, generators, transformers, fluorescent lights,
soldering irons, CRT displays, computers, electrical storms, welders, radio
transmitters, and internal sources such as semiconductors, resistors, and
capacitors. Noise corrupts signals you are trying to measure.

nonlinearity

For an amplifier, a measure of the maximum output deviation from an ideal
linear response in units of percent relative to full scale. The ideal linear
response is taken to be a straight line on a plot of measured output voltage
to measured input voltage with the ends of the line connecting the extremes
of the plot at the full-scale limits.

O
offset error

The output of a system with a zero-volt input.

offset null
compensation

The provision in strain-gauge signal conditioning hardware to remove the
unwanted offset voltage present at the output of a strain-gauge bridge when
no strain is applied.

overvoltage protection

Maximum voltage that does not cause hardware damage.

P
passband

The range of input frequencies that are passed to the filter output without
attenuation.

Poisson’s ratio

The negative ratio of transverse strain to longitudinal (axial) strain.

pole

A term used to describe the quality of a lowpass filter. In general, the more
poles a lowpass filter has, the better it attenuates frequencies beyond the
cutoff frequency.

port

A digital port consisting of multiple I/O lines on a E/M Series DAQ device.

pp

Peak to peak.
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ppm

Parts per million.

PXI

PCI eXtensions for Instrumentation—An open specification that builds on
the CompactPCI specification by adding instrumentation-specific features.

Q
QTR

Terminal for connection to a quarter-bridge completion resistor.

quarter bridge

A Wheatstone bridge consisting of one active strain gauge and three passive
fixed-valued resistors.

quarter-bridge
completion resistor

The bridge completion resistor in series with the active strain gauge in a
quarter-bridge configuration; the quarter-bridge completion resistor must
have the same nominal resistance value as the strain gauge.

R
Rg

Gauge resistance.

RL

Line resistance.

RMA

Return Material Authorization.

rms

Root Mean Square—The square root of the average value of the square of
the instantaneous signal amplitude; a measure of signal amplitude.

rolloff

The ratio that a system attenuates signals in the stopband with respect to the
passband, usually defined in decibels per octave.

RSVD

Reserved bit, pin, or signal.

RTI

Referred To Input—Calculates a specification relative to the input range.

S
s

Seconds.

S

Samples.

S/s

Samples Per Second—Used to express the rate at which an E/M Series
DAQ device samples an analog signal.
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sample

An instantaneous measurement of a signal, normally using an
analog-to-digital converter in an E/M Series DAQ device.

sample rate

The number of samples a system takes over a given time period, usually
expressed in samples per second.

scan

One or more analog samples taken at the same time, or nearly the same
time. Typically, the number of input samples in a scan is equal to the
number of channels in the input group. For example, one scan acquires one
new sample from every analog input channel in the group.

scan rate

The number of scans a system takes during a given time period, usually
expressed in scans per second.

SCXI

Signal Conditioning eXtensions for Instrumentation.

SCXIbus

Located in the rear of an SCXI chassis, the SCXIbus is the backplane that
connects modules in the same chassis to each other.

sensor

A device that converts a physical phenomenon into an electrical signal.

SER CLK

Serial clock signal used to synchronize digital data transfers over the
SER DAT IN and SER DAT OUT lines.

SER DAT IN

Serial data input signal.

SER DAT OUT

Serial data output signal.

shunt calibration

The method of calibrating the gain of a strain-gauge data acquisition
channel by placing a resistor of known value in parallel with a bridge
element.

signal conditioning

The manipulation of signals to prepare them for digitizing.

simulated strain

A strain measurement where the change in bridge output voltage is not
caused by deformation of the specimen being measured; rather, it is caused
by temporarily connecting a known resistance in parallel with one of the
bridge elements while all the strain gauges in the bridge remain unstrained.

Slot 0

Refers to the power supply and control circuitry in the SCXI chassis.

SLOT 0 SEL

Slot 0 select signal.

SPI CLK

Serial peripheral interface clock signal.
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STC strain gauge

Self-Temperature Compensating strain gauge—Has a resistive temperature
coefficient that counteracts the thermal expansion coefficient of the
material to which the gauge is bonded; thus, makes the system insensitive
to changes in temperature.

strain

The fractional deformation of a body under an applied force; is usually
given in the units of microstrain, where one microstrain represents a
deformation of 10–6, or 0.0001%.

system noise

A measure of the amount of noise seen by an analog circuit or an ADC
when the analog inputs are grounded.

T
tensile strain

Strain that results from an object being stretched; has a positive value.

typ

Typical.

U
UL

Underwriters Laboratory.

V
V

Volts.

VDC

Volts, direct current.

VI

Virtual Instrument—(1) A combination of hardware and/or software
elements, typically used with a PC, that has the functionality of a classic
stand-alone instrument.
(2) A LabVIEW software module (VI), which consists of a front panel user
interface and a block diagram program

virtual channels

Channel names that can be defined outside the application and used without
having to perform scaling operations.

voltage excitation

A source that supplies the voltage needed by a sensor for its proper
operation.

Vr

V CH
CH
V
--------–  -------- V EX  STRAINED  V EX  UNSTRAINED
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W
W

Watts.

Wheatstone bridge

A circuit arrangement consisting of four resistive elements in a diamond
pattern; with excitation voltage applied across two opposing terminals,
small resistance changes in the elements are easily detected by measuring
voltage changes across the remaining two terminals.
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connected (table), C-2
dynamic specifications, A-2
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calibration
internal calibration
overview, 5-12
shunt calibration
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configuration settings
excitation level, 3-1
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null potentiometers, 3-2
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electromagnetic compatibility
specifications, A-6
environmental specifications, A-5
excitation
questions about, C-4
setting excitation voltage level, 3-1
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B
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filters
questions about, C-4
specifications, A-2
front connector, pin assignments (table), 2-2

I-1

SCXI-1521/B User Manual

Index

G

N

gain

NI-DAQ software, C-1, C-3
null compensation
specifications, A-2
theory of operation, 4-8
null potentiometers
coarse and fine control codes (table), 4-8
configuring, 3-2
questions about, C-4

configuration, 3-2
questions about, C-4

I
installation
connecting to DAQ device for
multiplexed scanning
in PXI combination chassis, 1-4
removing SCXI-1521/B
from Measurement & Automation
Explorer, B-1
from SCXI chassis, B-1
software installation, 1-4
internal calibration. See calibration

O
operation of SCXI-1521/B. See theory of
operation

P
physical specifications, A-4
pin assignments
front connector (table), 2-2
terminal assignments, 2-1
potentiometers. See null potentiometers
power requirements (from SCXI
backplane), A-4
power-up state of SCXI-1521/B, C-4
PXI combination chassis, 1-4

L
LabVIEW software, questions about, C-3

M
Macintosh operating system, C-3
maximum working voltage specifications, A-5
Measurement & Automation Explorer
removing SCXI-1521/B, B-1
self-test verification
troubleshooting, 1-6
measurements
calibrating SCXI-1521/B, 5-12
pin assignments
terminal assignments, 2-1
multiplexed mode operation
connecting to SCXI-1521/B for DAQ
device
in PXI combination, 1-4
questions about, C-3
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R
random scanning, C-3
regulatory compliance specifications, A-6
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Explorer, B-1
from SCXI chassis, B-1
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environmental, A-5
excitation, A-3
filter, A-2
maximum working voltage, A-5
null compensation, A-2
physical, A-4
power requirements (from SCXI
backplane), A-4
regulatory compliance, A-6
safety, A-5
shunt calibration, A-3
stability, A-2
transfer, A-1
stability specifications, A-2
strain gauge connections
quarter-bridge configuration I, 4-3

safety specifications, A-5
SCXI chassis
installing SCXI-1521/B, 1-4
removing SCXI-1521/B, B-1
SCXI-1310 connector and shell assembly, 1-2
SCXI-1317 terminal block, C-4
SCXI-1502, dimensions (figure), A-4
SCXI-1521/B
block diagram, 4-6
calibration, 5-12
common questions, C-1
configuration settings, 3-1
digital signals (table), C-2
installation, 1-4
specifications, A-1
taking measurements. See measurements
theory of operation
excitation, 4-8
null compensation, 4-8
shunt calibration, 4-9
self-test verification, troubleshooting, 1-6, C-1
shunt calibration
questions about, C-4
specifications, A-3
theory of operation, 4-9
signal connections
digital signals (table), C-2
front connector
pin assignments (table), 2-2
software
application development environments
supported, 1-4
installation, 1-4
NI-DAQ version required, C-1
specifications
analog input, A-1
bridge completion, A-3
dynamic, A-2
electromagnetic compatibility, A-6
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taking measurements. See measurements
TBX-96 terminal block, 1-2
theory of operation
block diagram, 4-6
excitation, 4-8
null compensation, 4-8
shunt calibration, 4-9
transfer specifications, A-1
troubleshooting
incorrect test and verification, C-1
questions and answers, C-1
self-test verification, 1-6

V
verifying and self-testing the configuration
troubleshooting, 1-6, C-1
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